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speci� cations.
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elevated temperatures, may cause damage to the system if 
the enclosure's internal temperature exceeds the temperature 
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4. Do not alter product construction.
5. For use with clean fresh water only.
6. Disconnect AC power before opening wiring enclosure.
7. This panel system uses AC voltages. Wiring should be done by 

quali� ed personnel only. 
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 2. Quick Start Up Guide

Follow the steps below to set up a new Chlorine Analyzer System.  Refer to the individual component manuals for detailed information.

 1. 4630 Chlorine Analyzer System Inventory

Step 1. Mount the panel on a vertical � at surface using appropriate hardware.

Step 2. Open the wiring enclosure and wire input power (see section 8 and 8.1: Wiring Inputs/Outputs).

Step 3. Wire any 4 to 20 mA and relay output.

Step 4. Remove sensor access plugs from the � ow cell (Figure 1). If the optional pH sensor is NOT used,
 do not remove remove the left-side plug from the � ow cell.

Step 5. Install sensor into the electronics (see section 10: Sensor Installation). Chlorine sensor is installed in the right-side 
access port, optional pH sensor is installed in the left-side access port.

Step 6. Remove the protective cap from the electrode tip and install the electrode into the � ow cell.
 (Keep the electrode tip cap in a safe place for future use. It is recommend to use the cap to protect the
 sensor during the removal of the electrode for cleaning or maintenance of the � ow cell).

NOTE: All new chlorine and pH sensors require calibration during the start up of a system and also throughout the life of the sensor. 
A new chlorine sensor requires a 4-hour conditioning period with power on and water � owing past the sensor prior to 
calibration. Refer to section II, section 7 for chlorine calibration and set up procedure.

NOTE: If optional pH sensor is not being used, pH must be "hard-coded" into the system. Refer to section II, section 5.3 for manual 
pH compensation.  If optional pH sensor is installed, refer to section II, section 5 to calibrate pH electrode.

Step 7. Repeat step 5 and 6 if the optional pH sensor is being used.

Step 8. Install the in� uent water source to the "Inlet Port" nipple assembly of the � ow cell. Install 3/8 inch tubing and secure 
with a hose clamp. (Not included. See section I, section 10)

Step 9. Install 3/8 inch tubing and secure with a hose clamp on the "Drain" port 
and direct the tube to a proper drain. (Not included. See section I, section 
10)

Step 10. Verify the inlet and drain ball valves are in the open position and the 
sample port is in the off position (See section I, section 11: Tubing 
Connections).

Step 11. Turn on the in� uent water source and check the system for leaks.

Step 12. Apply power to the system, and allow system to initialize.  Calibrate per 
instructions (See section II, sections 5 and 7).

Do not turn on power at this time.

1. Chlorine panel assembly
 a. Built-in pressure regulator 15 to 120 psi.
 b. 3/8 inch hose barb connectors.
2. 1 each 3-2630-2 Free Chlorine sensor with protective cap
 a. 1 spare membrane cap
 b. 1 bottle of electrolyte solution
 c. 1 syringe needle (taped to bottle)
 d. 1 syringe
3. 1 each Flat pH sensor 3-2724-00 (159 001 545) (3-4630-21 model only)
4. Manual package
 a. English panel assembly manual
 b. CD with multi-language manuals
 c. Wall mounting hardware
 d. Drill template
5. 1 each North American Type B power cord
6. Customer supplied
 a. 3/8" hose input and drain
 b. Hose clamps

Sensor access plugs 

Figure 1
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The Signet Chlorine Analyzer System is an integrated, all-in-one chlorine panel system designed to measure free chlorine in 
drinking water and clean fresh water treatment applications.

Features:
• Complete chlorine analyzer system allows quick setup and easy installation. 

Connect to a water source and plug it in.
• Unique integrated clear � ow cell combines sensors, � ow regulator, � lter and 

variable area � ow indicator in one compact unit.
• Built-in variable area � ow indicator facilitates � ow rate con� rmation at a 

glance.
• Integrated � ow regulator with removable � lter accepts inlet pressures of 1 to 

8 bar (15 to 120 psi) while maintaining constant � ow and minimal pressure 
to the sensors.

• Water � ows vertically into sensor tip, eliminating bubble entrapment. Raised 
exit in � ow cell sensor chamber ensures sensors stay submerged even 
when system and � ow is turned off. 

• Flow cell accommodates two sensors; one chlorine and an optional pH 
sensor.

• Automatic pH and temperature compensation or manual pH value input 
capability for chlorine reading accuracy.

• Easy viewing of the transmitter via the bright backlit LCD display.
• Moisture proof NEMA 4X wiring enclosure.

 3. Description

Additional information can be found in the individual product manuals, refer 
to www.gfsignet.com. Click on Product Manuals under the Signet Quick Links 
section.

• 8630-3P Chlorine Transmitter Manual
• 2630-2 Amperometric Chlorine Electrode Manual
• 2650 Amperometric Electronics Manual
• 2724 pH/ORP Electrode Manual
• 2750-7 pH Electronics Manual
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 4. Dimensions

Hand Holds
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 5. Panel Assembly

Power cable conduit

Amperometric chlorine 
sensor electronics 

3-2650-7 (159 001 670)

Flow cell block

Flow cell O-rings

Vent 
Cap

Output conduits

Transmitter
3-8630-3P (159 001 673)

Wiring enclosure

Flow rate indicator

Flow range limits

Flow regulator with strainer

Inlet port

Drain port
(3/8 inch hose)

Sampling port

pH sensor
electronics

 3-2750-7 (159 001 671)

pH electrode 
3-2724-00 (159 001 545)

Quick disconnect plug
(3/8 inch hose) 

2000-3825*

Quick disconnect 
2000-2525*

3/8" Hose barb
2000-3804*

3/8" Ball valve 
4300-5225*

Chlorine electrode 
3-2630-2 (159 001 662)

* Contact factory for quote
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Flow cell front block

Disc spring (2700-0003)*

Spacer ring
Stainless steel � lter

Pressure regulator

Pressure regulator outer O-ring (large)

Pressure regulator outer O-ring (small)
Flow cell O-rings (4 segments)

Flat washer

Flat washer*

Disc spring (curved washer)

Knurled thumb nut (1700-2512)*

Flow cell bolt (2490-0554)

Included in kit 3-4630.390
Item Quantity
Flow cell nut 6
Flat washer 15
Disc spring 9
Knurled thumb nut 3
Flow cell bolt 6

Flow cell nut

Flat washer

Flow cell back block

Regulator Assy
(3-4630.391)

Flow Cell Rebuild Kit
(3-4630.390)

 6. Component Identifi cation: Flow Cell

*Not included with 
3-4630.392

4-4630.392
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 7. Mounting

NO

• Indoors is recommended.
• Mount the panel according to local electrical, building, and or plumbing codes and seismic 

requirements.
• The panel must be mounted vertically in an upright position.
• Use four 6 mm (¼ in.) diameter screws or bolts of suf� cient length to mount the panel to a sturdy 

vertical surface.  A mounting template is provided.
• Allow clearance on the sides and bottom for service to the unit.
• Bright light can promote algae growth.
• Keep panel system electronics and enclosure away from dripping water.
• If the system is mounted outdoors, an outdoor enclosure for the whole system must be used to 

protect the electronics and � ow cell from light, rodents, insects and dirt. 

Mount out of direct sunlight.
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Input for
100-240 VAC

100 to 240 VAC input
    Standard AC confi guration

WARNING
This panel system is wired for AC voltages that can injure 
or kill. Wiring should be done by qualifi ed personnel only. 
Disconnect AC power before opening wiring enclosure.

12 to 24 VDC Input Wiring Conversion

• If the power source supplied to the system will be 12 to 24 VDC 
instead of 100 to 240 VAC, disconnect the red and black output wires 
from the power supply (Figure 3) and connect your DC power source 
to them (Figure 4).

• Insert input power wiring into the pre-drilled access hole on the left 
side of the electrical box using the appropriate conduit adapters to 
maintain the Type 4X rating. (Customer may have to remove the 
supplied conduit connectors.)

• A switch or circuit breaker rated at 5 amps DC shall be included in 
the building installation.

• Install the circuit breaker in close proximity to the equipment and 
within easy reach of the operator.

• Mark the circuit breaker as the disconnecting device for the 
equipment.

Power Supply Terminal Identifi cation 
Terminal Name Description
V. ADJ Voltage adjustment Adjusts within ±10%; turning clockwise 

increases output voltage
DC ON  Operation indicator Green LED is lit when output voltage 

is on 
+V, –V   DC output terminals +V: Positive output terminal

–V: Negative output terminal 
L, N  Input terminals Accepts a wide range of voltages 

and frequencies (100 to 240 VAC DC 
input)

100 to 240 VAC Input Wiring 

• Open the electrical box by loosening the four corner screws of the 
front cover.

• Insert input power wiring into the pre-drilled access hole on the left 
side of the electrical box using the appropriate conduit adapters to 
maintain the Type 4X rating. (Customer may have to remove the 
supplied conduit connectors.)

• Install the input power wires into the proper terminals on the power 
supply (Figure 2). Use only 12-26 AWG copper wiring.

• Recommended torque for the terminals is 7 lb-in.

NOTE: When using alternate power supply 7300-7524:
• Use 10-24 AWG copper wiring, 105�C, torque 4.4 lb-in.

Figure 2

System Input Power

• The panel system is pre-wired with an auto switching power supply 
that is rated for 100 to 240 VAC 50/60 Hz input.

• Wire with NEC Class I, 300 volt, 105 C wire.
• A switch or circuit breaker rated at 15 amps AC shall be included in 

the building installation.
• Install the circuit breaker in close proximity to the equipment and 

within easy reach of the operator.
• Mark the circuit breaker as the disconnecting device for the 

equipment.

 8. Wiring Input

Figure 3

+
–

Figure 4

Part # 7300-0024 shown. Actual power supply may differ from Figure 2.

Follow all local and government recommendations and methods for installation of 
electrical connections to and between the system and other devices.
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WARNING
This panel system is wired for AC voltages that can injure 
or kill. Wiring should be done by qualifi ed personnel only. 
Disconnect AC power before opening wiring enclosure.

Wiring Label Legend

Ground Earth Ground. Attach 4 to 20 mA loop cable 
shield wire here to help eliminate possible noise.

Loop 1 4 to 20 mA Loop #1
Loop 2 4 to 20 mA Loop #2
Relay 1 Relay Output #1

NC Relay Normally Closed when un-energized 
(contact)

C Common

NO Relay Normally Open when un-energized (no 
contact)

Relay 2 Relay Output #2 (terminals same as Relay #1)

Follow all local and government recommendations and methods 
for installation of electrical connections to and between the 
system and other devices.

Output Connections
• Use the wiring enclosure terminal block for output wire 

connections. Do not wire directly to the transmitter.
• Recommended torque for the terminals is 7 lb-in
• Do not run 4 to 20 mA loop cables in the same conduit as the 

power or other high voltage wiring.
• Remove one installed jumper wire (from both of its terminals) 

on the terminal block in the enclosure for each loop device 
connected. Replace the jumper if you later remove your loop 
device. If only one loop device is connected, remove just one 
jumper wire from its two terminals.

• The panel system uses an active loop output wired to the 
enclosure terminal block.

• If connecting to a PLC, use the PLC's passive input.

• The transmitter must have a jumper wire or loop device 
always connected to Loop 1.

PLC Terminals 

Channel 2
4 to 20 mA

Channel 1
4 to 20 mA

+
-

+
-

    1  2  3  4  5  6  7  8  9  10

+  -
+  -

NC   C   NO NC   C   NO 

LOOP  1

LOOP  2

GROUND

RELAY  1

RELAY  2

GND

PLC dual channel connection

to 4 to 20 mA
 loop device

Wiring a 4 to 20 mA loop device

 Jumper wire removed

 8.1  Wiring Output
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 9.   Electrical Box Wiring Schematic
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 10. Sensor Installation 

• Remove applicable sensor access plugs from the � ow cell (pg. 2, Figure 1). Holding the 3-2750-7 or 3-2650-7 electronics 
inverted, open the DryLoc® connector by turning the upper locking ring ¼-turn counter-clockwise. Insert the electrode facing 
up. Turn the locking ring ¼-turn clockwise to lock the electronics in place. The mechanism will “click” when it is locked. Install 
the complete assembly into the � ow cell and ensure the key on the electrode aligns with the key slot on the � ow cell.

DryLoc® Connection to Sensor Electronics

Locking RingLocking Ring
LockLock

3-2724-00
pH electrode

3-2630-2
FCL electrode

3-2750-1 
pH electronics 

3-2650-7
Amperometric Electronics
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IN
OUT

pH Cl

 12.   Water Flow

OK

Flow Rate

The � ow rate is in the proper range when the � oat is between the Min. and Max. markers on the � ow cell. The � ow range limits are 
30.24 to 45.36 L/h (8 to 12 gal/h).

Inlet Drain
(to atmosphere)

Sampling port 
(� ow off)

 11.   Tubing Connections

• Use suitable 9.5 mm (3/8 in) ID tubing that is rated for your inlet pressure. 
Use hose clamps.

Valve position for start up and normal use.

Note: Turn off inlet valve � rst when stopping water 
� ow. 

• The drain tube must be positioned lower than 
the in� uent water source to allow proper � ow 
through the � ow cell. The � ow cell must drain by 
gravity, not system pressure.

Inlet Quick Release Connection

Press down gray plunger to release. Water � ow 
is automatically shut off when disconnected.

For Low Flow applications (� ow less than 1 bar/15 psi), 
the Flow Regulator can be removed and the � ow 
adjusted using the Flow Cell ball valve. (NOTE: The 
inlet hose barb will also need to be changed. Contact 
factory for details.)
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 2. Transmitter Editing Procedure

• The 8630-3 has two menus the user can edit; CALIBRATE and OPTIONS. 
• The CALIBRATE menu allows you to calibrate and initialize sensors, de� ne current loops and set relay functions.
• The OPTIONS menu allows you to set sensor type, adjust and test current loops, test relays and more.

Step 1. Press and hold the ENTER key:
  •  2 seconds to select the CALIBRATE menu.
  •  5 seconds to select the OPTIONS menu.

Step 2.   Enter the Key Code.
  The Key Code is UP-UP-UP-DOWN keys in sequence.
  •  After entering the Key Code, the display will show the � rst item in the selected menu.

Step 3.   Scroll the menu in a loop with the DOWN or UP arrow keys.

Step 4. Press the RIGHT ARROW key to select the menu item to be edited.
  •  The � rst display element will begin � ashing.

Step 5.   Press the UP or DOWN keys to edit the fl ashing element.
  •  The RIGHT ARROW key advances the � ashing element.

Step 6.   Press the ENTER key to save the new setting and return to Step 3.

Press the UP and DOWN keys simultaneously 
while any element is � ashing. This will recall the 
last saved value of the item being edited and will 
return you to Step 3.

Made an Error?
Press the UP and DOWN keys simultaneously 
after saving the last setting to return to view menu.

Finished Editing?

The example View menus below return to the default display after 10 minutes.

FCl:  2.67 ppm
7.10 pH  25.3 °C

View chlorine, pH and temperature values from the sensor.
FCl = free chlorine.

Cl Raw:  103.8 nA
pH Raw:  -5.9 mV

Chlorine (nA) and pH raw (mV) signals from the sensors. 
For reference only.

Loop 1   10.68 mA
Loop 2    8.56 mA View of current loop 1 and loop 2 output.

Last CAL:
10-18-10 View of the last calibration date. Editable in the Calibrate Menu.

Section II - 8630 Chlorine Transmitter

• The View Menu is displayed during normal operation.
• To select a VIEW display, press the UP or DOWN arrow keys. The selections will scroll in a continuous loop. There are four pages 

to view.
• Changing the VIEW display does not interrupt system operations.
• No key code is necessary to change display selection.
• Output settings cannot be edited from the VIEW menu.
• All menus time-out after 10 minutes and return to the previous operating display.
• When editing the CALIBRATE or OPTIONS menus, the transmitter will return to the non-edit
 display after 10 minutes and then the VIEW menu in another 10 minutes if no activity occurs.

CAUTION!
•   Remove power to unit before wiring input or output connections.
•   Follow instructions carefully to avoid personal injury or damage to the transmitter.

 1. The View Mode
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Access the CALIBRATE Menu:
The CALIBRATE and OPTIONS menus require a KEY CODE.
Press and hold the ENTER key for 2 seconds to access the 
CALIBRATE menu.

Step 1.ENTERENTER

2sENTERENTER

(Hold)

CALIBRATE menu

5s OPTIONS menuOR

2.1   Example: Calibration

ENTERENTER

Step 6.
ENTERENTER

Edit the fl ashing element:
This is the edit mode.
The UP or DOWN keys change the � ashing element.
The RIGHT arrow key advances the � ashing element in a 
continuous loop. In this example, the "Last Cal" date was 
changed from 09-18-09 to 10-18-09.
All output functions remain active during editing.
Only the � ashing element can be edited.

Step 5.

Press ENTER to save the new value.
When you have set your desired value, pressing the ENTER key 
stores the value on the screen, making it immediately available to 
output functions and exits you back to Step 3.

 Enter the Key Code:
Pressing the UP, UP, UP, DOWN keys in sequence unlocks the 
display and the � rst menu item will appear. If no key is pressed 
for 5 minutes while the display is showing "Enter Key Code", it will 
return to the VIEW menu.

Step 2.

Press the UP and DOWN keys simultaneously 
while any element is � ashing. This will recall the 
last saved value of the item being edited and 
return you to Step 3.

Made an Error?
Press the UP and DOWN keys simultaneously 
after saving the last setting to return to the View 
Menu.

Finished Editing?

Example

Step 3.
Scroll the Menu:
Press the DOWN or UP keys to scroll through the Menu. 
Refer to pages 3 and 4 for complete listing of these items.
While in this mode, pressing the UP and DOWN keys 
simultaneously will return the display to the VIEW menu.
If no key is pressed for 10 minutes, the display will return to the 
VIEW menu.

Step 4.
Select the item to be edited:
In this example, "Last Cal" (last calibration date) is chosen to edit. 
Pressing the RIGHT arrow key selects the menu item and enters 
the screen into edit mode.

Cl Zero
Calibration:    >  

CALIBRATE:----
Enter Key Code  

CALIBRATE:---
Enter Key Code

CALIBRATE:--
Enter Key Code

CALIBRATE:-
Enter Key Code

Cl Zero
Calibration:    > 

 

Last Cal:
   09-18-09   
Last Cal:
   19-18-09

Last Cal:
   19-18-09
Last Cal:
   10-18-09

Last Cal:
    Saving 
Last Cal:
   10-18-09

Last Cal:
    09-18-09    > 

Last Cal:
    09-18-09    > 



14 4630 Chlorine Analyzer System

  Cl Zero
Calibration:    >

When > is pressed, the “live” readings are shown. The nA value is displayed, but cannot be 
edited and is used for diagnostic and calibration purposes. When in Edit Mode, pressing Enter 
stores the displayed value as your zero reference. Example on Section 15.

Cl In Process
 Calibration:   > Enter process chlorine value determined from a DPD test kit here. Example on Section 15.

Cl Temperature
 Calibration:   >

Enter process temperature from a reference thermometer: °C or °F. Units are set up in the 
Options Menu. Example on Section 15.

Reset Cl to
Factory Cal:    >

This menu resets Cl readings, Zero Calibration and temperature back to Factory Calibration. 
WARNING! User entered Cl calibration settings will be lost.

pH Standard
Calibration:    >

Set pH offset value. This applies a linear offset to the pH measurement. 
Example on Section 13.

pH Slope
Calibration:    >

Applies a slope to the pH measurement. The slope and standard value must be at least 2 pH 
units apart. Example on Section 13.

Reset pH to
Factory Cal:    >

Reset pH standard, slope or back to Factory Calibration.
WARNING! User entered pH calibration settings will be lost.

Chlorine Units:
     ppm        > This is the � rst screen. Choose units of measurement of ppm or mg/l.

Loop 1 Source:            
  Chlorine      > Choose chlorine or pH for this 4 to 20 mA current loop. Example on Section 16. 

Loop 1 Rng: ppm
  0.00   5.00  >

Select the minimum and maximum values for the current loop output. Units are derived from 
Loop 1 Source. If the Source 1 is changed, be sure to re-edit this page.

Loop 2 Source:            
    pH          > Choose pH or chlorine for this 4 to 20 mA current loop.

Loop 2 Rng: pH
 00.0  14.00   >

Select the minimum and maximum values for the current loop output. Units are derived from 
Loop 2 Source. If Source 2 is changed, be sure to re-edit this page.

 3. Calibrate Menu Defi nitions

Calibrate Menus
- Factory settings shown - Description

Current Output Functions

NOTE:
For greater accuracy it is recommended that the initial calibration of the system in the following order
1. Temperature
2. pH electrode (if optional pH sensor is purchased. If manual pH sensor is selected enter the pH value into the option 

menu prior to calibrating the chlorine sensor)
3. Chlorine sensor

• Although the Calibrate Menu can be navigated upwards or downwards, it is best to navigate downwards when editing 
Current Loop and Relay settings as previous entries can in� uence subsequent menus.

• Chlorine and pH calibration screens will be shown only when a valid sensor is detected.

The menus below are displayed here in the order seen when scrolling down through the Calibrate Menu.

NOTE: The next two pH calibration screens will be shown only when a valid pH sensor is detected.

Press the Up or Down Arrow 
key to scroll through the menus

Press the Right Arrow key to enter 
edit mode

Press the Enter key to save your 
settings

ENTERENTER
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If Pulse Mode was chosen:

Relay 2 Mode:
      Off       >

Choose Relay 2 mode of operation: Off, Low, High, Window, or Pulse. 
To disable this relay choose Off.

Relay 2 Source:
     pH         >

Choose pH or chlorine for Relay 2. This menu screen and all subsequent Relay 2 
screens below do not appear if Relay 2 Mode is set to Off. 

Relay 2 Setpnt:
    0.00 pH     >

In Low or High Mode, Relay 2 will be activated when the process reaches this value. 
Units of measure re� ect Relay 2 Source.

Relay 2 Hys:
    0.20  pH    >

Relay 2 will be deactivated at Relay 2 Setpoint ± this hysteresis setting depending on 
High or Low Setpoint selection.

Relay 2 Delay:
      0.0 secs  >

Set the time delay for Relay 2 to activate after reaching the Setpoint. 
Range: 0 to 6400 seconds.

If Low or High Mode was chosen:

Relay 1 Hys:
    0.20  ppm   > Relay 1 will be deactivated at Range setpoints ± this hysteresis setting.

Relay 1 Delay:
    0.0  secs   > Set time delay for Relay 1 to activate after reaching the setpoints set in Relay 1 Range.

Relay1 Rng: ppm
  0.00  5.00   > Enter the range where Relay 1 will activate above and below this setpoint.

Relay1 PlsRate:
120 pulses/min  > Set the maximum pulse rate. Range: 1 to 400 pulses/min.

Relay 1 Mode:
    Off         >

Choose mode of operation: Off, Low, High, Window, or Pulse. If Off, all subsequent Relay 1 
functions are inactive and not visible. Example on Section 16.3.

Relay 1 Source:
     Chlorine   > Choose chlorine or pH for Relay 1.

Relay 1 Source:
     Chlorine   > Choose chlorine or pH for Relay 1. 

Relay 1 Source:
     Chlorine   > Choose chlorine or pH for Relay 1. 

Relay 1 Setpnt:
    0.00 ppm    >

In Low or Hi Mode, Relay 1 will be activated when the process reaches this value. 
Units of measure re� ect Relay 1 Source. 

Relay 1 Hys:
    0.20  ppm   >

Relay 1 will be deactivated at Relay 1 Setpoint ± this hysteresis setting depending on 
High or Low Setpoint selection.

Relay 1 Delay:
      0.0  secs >

Set the time delay for Relay 1 to activate after reaching the Setpoint. 
Range: 0 to 6400 seconds.

Relay Functions

If Low or High Mode was chosen:

If Window Mode was chosen:

Relay1 Rng: ppm
  0.00  5.00   > Enter the range where Relay 1 will activate above and below this setpoint.

Verify all relay settings if the Relay Source is changed.

 Calibrate Menu - continued
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Options Display
(Factory settings shown) Description

 4.   Options Menu Defi nitions

   Contrast:
       3        > Adjust the LCD contrast for best viewing. A setting of 1 is lower contrast, 5 is higher.

Cl Sensor Type:
    Free Cl     > Select the chlorine sensor: Free Cl.

   pH Input
     Sensor     >

Choose Manual or Sensor. If Sensor is chosen, the pH value from the connected pH sensor will 
be used. Choose Manual to enter a pH value manually when no sensor is connected.

Temp Display:
       °C       > Choose units of °C or °F.

   Averaging:
       Off      >

OFF gives the fastest response to input changes. LOW = 4.5 seconds, HIGH = 9 seconds of 
averaged response. Increase averaging to steady the display.

Manual pH Value
    7.000 pH  Enter your pH value here if a pH sensor is not connected.

If Manual pH input was chosen:

Relay2 Rng: pH
  0.00  14.0   > Enter the range where Relay 2 will activate above and below this setpoint.

Relay2 PlsRate:
120 pulses/min  > Set the maximum pulse rate. Range: 1–400 pulses/min.

If Pulse Mode was chosen:

   Find New
    Sensor(s):  > Required only when a new sensor is changed while the power is on. Choose Yes or No.

Last Cal
    10-18-09    > Edit the calibration date.

End of Calibrate Menu 

Relay 2 Rng: ppm
  0.00  5.00   > Enter the range where Relay 2 will activate above and below this setpoint.

Relay 2 Hys:
    0.20  ppm   > This relay will be deactivated at Relay 2 Range setpoints ± this hysteresis.

Relay 2 Delay:
      0.0  secs >

Set the time delay for Relay 2 to activate after reaching the setpoints set in the 
Relay 2 Range.

If Window Mode was chosen:

Relay 2 Source:
     pH         > Choose pH or chlorine for Relay 2.

Relay 2 Source:
     pH         > Choose pH or chlorine for Relay 2.

 Calibrate Menu - continued

5s OPTIONS menu

Press the Up or Down key to 
scroll through the menus

Press the Right Arrow key to enter 
edit mode

Press the Enter key to save your 
settings

ENTERENTER
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 Options Menu - continued

Options Display
(Factory settings shown) Description

Zero Cal: ppm&nA
 xxx.xx  xxxx.x View user entered Zero Calibration data in ppm and nA.

Temp at Cal:
     xxxx.x °C Temperature recorded during user In-Process Calibration.

pH at Cal:
     xxx.xx pH pH value recorded during user In-Process Calibration.

In Proc: ppm&nA
 xxx.xx  xxxx.x View user In-Process Calibration value when it was entered in the Calibrate Menu.

Temp Offset:
     xxxx.x °C Temperature offset calculated from user entered temperature calibration from Calibrate Menu.

Elapsed Time:
   xxxxx.  hrs Total hours of operation.

Low & High: °C    
-xxxx.x   +xxxx.x Lowest and highest temperatures the Cl sensor has been subjected to during operation.

Test Loop 1:   
                >

Press UP or DOWN keys to manually output any current value from 3.6 mA to 21.00 mA to 
test Loop 1 output.

Test Loop 2:   
                >

Press UP or DOWN keys to manually output any output current value from 3.6 mA to 
21.00 mA to test Loop 2 output.

Test Relay 1:   
                >

Press UP or DOWN keys to manually toggle Relay 1 Off and On. The left LED on the front 
of the transmitter con� rms operation.

Test Relay 2:   
                >

Press UP or DOWN keys to manually toggle Relay 2 Off and On. The right red LED on the
 front of the transmitter con� rms operation.

Read Sens Data:   
      No       >

If "YES" is selected the following (Read Only) screens will be shown. 
If "NO" then this menu ends the Options Menu.

Cl Sensor S/N:
   xxxxxxxxx View the sensor serial number.

Cl Type & Range:
 2630  xxx.x ppm Identify the chlorine sensor type connected and its ppm range.

If Yes was chosen:

Loop 1 Adjust:   
      4.00 mA   >

Adjust the minimum current output for Loop 1. The display value represents the precise 
current output. Range: 3.80 mA to 5.00 mA.

Loop 1 Adjust:
     20.00 mA   > Adjust maximum current output for Loop 1. Range: 19.00 mA to 21.00 mA.

Loop2 Adjust:   
     4.00 mA    > Adjust the minimum current output for Loop 2. Range: 3.80 mA to 5.00 mA.

Loop2 Adjust:   
    20.00 mA    > Adjust maximum current output for Loop 2. Range: 19.00 mA to 21.00 mA.

   Decimal:
    ***.**      > Select the decimal point for the display. Maximum of 2 decimal places.

End of Options Menu 
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 5. pH Sensor Calibration

System Start-up: Step 3
If a pH sensor is part of the system, use the GF Calibration Kit 3-2700.395 (159 001 605) prior to initially installing the sensor and 
during its normal lifetime.  If a pH sensor is not available but pH determination is necessary, measure process pH with a separate 
test and enter the value in the Options Menu. Next step: Chlorine Sensor Conditioning (see section 6, page 24).

View Menu 

Calibrate Menu 

FCl:  2.67 ppm
7.11 pH  25.3°C

pH Standard
Calibration:    >

ENTERENTER

2sENTERENTER

(Hold)

5X

pH Standard Cal:
07.00 pH/ 0 mV

pH buffer value 
entered here

6

7

5

8

      Step 4

E X A M P L E
Refer to your pH sensor manual. 

The pH sensor needs to be calibrated against two different pH 
buffer references to calibrate the offset (standard) and slope. 
Electrode offset is any deviation from 0 mV in a pH 7 buffer at 25 °C. 
Slope is the ratio of mV to pH units.
•  Always keep any output devices of� ine when calibrating. 

5.1   pH Offset (Standard)
The transmitter must be powered on and the pH sensor must be 
connected.
1. Turn off the water � ow through the system, then remove the 

pH sensor from its � ow cell.
2. Using pH buffer 7.0, place enough pH buffers into a 

clean calibration cup, supplied with the pH calibration kit 
3-2700.395 (159 001 605), to cover the tip of the electrode.

3. Pour distilled water in another clean cup for rinsing the 
electrode between buffers

4. Rinse probe, place the pH sensor in the pH 7.0 buffer and 
allow the mV reading to stabilize.

Example: Set pH Standard to 7.00.
 
5. Go to the Calibrate Menu.
6. Scroll down � 5 menus to the pH Standard menu.
7. Press � to enter Edit Mode.
8. Enter the pH value of the buffer that the electrode is placed 

in; 7.00 in this case. 
9. Press the Enter button to save the setting.
10. Exit to the View Menu. ��

5.2   pH Slope
1. Remove the pH sensor from the � rst buffer solution and rinse 

it in distilled water.
2. Place the pH sensor in a different buffer solution (example: 

pH 4.01). The pH standard and slope must be at least 2 pH 
units apart.

3. Note the pH and mV readings on the View Menu and allow it 
to stabilize.

Example: Set pH slope to 4.01.

4. Scroll down � 1 menus to the pH Slope menu.
5. Press � to enter Edit Mode.
6. Enter the pH value of the buffer that the electrode is placed 

in; 4.01 in this case. 
7. Press the Enter button to save the settings.
8. Exit to the View Menu.  ��

9. Replace the pH sensor back into its � ow cell.
10. Turn on the water � ow, the pH senor calibration is complete.

E X A M P L E

View Menu 

Calibrate Menu pH Slope
Calibration:    >

pH Slope Cal:
04.01 pH/ +177 mV

ENTERENTER

pH buffer value 
entered here

4

6

5

E X A M P L E

E X A M P L E

NOTE: The pH sensor will not calibrate when the mV value exceeds 50mV from the original new electrode speci� cation.  
Electrode: pH 4.01 = + 177 mV

pH Standard Cal:
07.00 pH/ 0 mV
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5.3   Manual pH Compensation 

If the pH of the application is stable, then the pH of the application 
can be entered manually and will be used to calculate the chlorine 
measurements.

Example: Change the pH input from Sensor to Manual and enter 
a pH value of 7.22.

1. Go to the Options Menu.
2. Scroll down � 2 menus to the pH Input menu.
3. Press � to enter Edit Mode.
4. Choose Manual and press Enter.
5. Scroll down � 1 menu to the Manual pH Value menu. 
6. Press � to enter Edit Mode.
7. Enter your new process pH value: 7.22.
8. Press the Enter button to save the setting.
9. Exit to the View Menu.

E X A M P L E

 6. Chlorine Sensor Conditioning

System Start-up: Step 4
A new chlorine sensor or one that has had the electrolyte or membrane replaced must be conditioned to generate stable and 
accurate readings. To condition a chlorine sensor, the sensor and sensor electronics must be installed and powered and must 
also have water fl ow across the membrane: 
Next step: Calibrating Chlorine (see section 7).

pH Input
     Sensor     >

pH Input
     Manual     >

pH Input
Sensor  Manual

Manual pH Value
    7.220 pH 

Manual chosen

New pH value entered

E X A M P L E

Options Menu Step 2

5

4

ENTERENTER

ENTERENTER

Chlorine Sensor Conditioning
1. Turn on and adjust water � ow rate. Condition a new chlorine sensor for 4 hours. Conditioning time for a membrane cap 
  replacement or electrolyte re� ll is 2 hours. 
2. Keep any 4 to 20 mA devices or relay actuated output devices that connect to the transmitter of� ine.
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 7. Chlorine Sensor Calibration

System Start-up: Step 5
Chlorine sensors need to be calibrated for accuracy. After the 4 hour conditioning period, Temperature Calibration, Zero Point 
Calibration and In-Process Calibration needs to be performed. Any 4 to 20 mA or relay output devices should be offl ine.
Next step: Setting Output Settings (see section 8).

7.2   Zero Point Calibration 
The chlorine sensor needs to be calibrated against two chlorine 
references: zero chlorine and the process chlorine. Typically the zero 
point calibration is very stable. Calibration must be done with every 
new sensor and any time a membrane cap is replaced.

1. Ensure any output devices are of� ine and disable relays.
2. Turn off the water � ow and remove the powered chlorine sensor 

with the electronics still attached.
3. Place the sensor tip in distilled water.
4. Wait until the reading stabilizes, then save the calibration. 

Stirring the sensor in water is not necessary, but allows the 
signal to stabilize faster. 

Example: Set the Zero Point Calibration at 1.0 nA.

5.  Go to the Calibrate Menu.
6.  Scroll down � one menu to the Cl Zero menu.
7.  Press � to enter Edit Mode. You will see � ashing the live sensor 

readings in ppm and nA. These readings cannot be modi� ed, but 
can only be saved as displayed.

8.  Press the Enter button at the lowest reading to save the setting 
or press           to escape without changes.

9.  Exit to the View Menu.

10. After Zero Point Calibration is complete, replace the sensor back 
into the � ow cell and turn the water � ow back on.

11. Wait until the chlorine readings stabilize once again, then perform 
a chlorine In-Process Calibration.

E X A M P L E

  Cl Zero:
Calibration     >

Zero Cal:  ppm&nA
    0.20 / 001.0

E X A M P L E

Calibrate Menu 

ENTERENTER

Lowest value noted for 
Zero Cal.

Step 6

8

The signal level during a Zero Point 
Calibration must be at least 1 nA lower 
than the In-Process Calibration point.

7.1   Chlorine Sensor Temperature Calibration
The temperature element inside the chlorine sensor needs to be 
calibrated. Use a reference thermometer at the same temperature 
and in the same medium as the immersed sensor.

Tip: Remove the pH electrode from the � ow cell and insert the 
reference thermometer. If no optional pH sensor is being used, 
remove the cell plug to insert the thermometer. Replace the plug after 
TC Calibration.

Example: Set the calibrated temperature to 25.3 ºC.

1. Go to the Calibrate Menu.
2. Scroll down � 3 menus to the Cl Temperature menu.
3. Press � to enter Edit Mode.
4. Enter the temperature reading. Example: 25.3.
5. Press the Enter button to save the setting.
6. Exit to the View Menu.

Step 2

4

 Cl Temperature
  Calibration:  >

Cl Temp:  Cal
  +025.3 °C

E X A M P L E

Calibrate Menu 

New temp. value
ENTERENTER

E X A M P L E
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8.1   Current Loop Settings
Current outputs are passive outputs that can be spanned in the 
forward and reverse direction. Example: 0 to > 5 or 5 to > 0.

Example: Set a current loop source as chlorine and the 
operational range to 0 to 5 ppm.

1. Go to the Calibrate Menu.
2. Scroll down � to the Loop 1 Source menu.
3. Press � to enter Edit Mode.
4. Choose either the chlorine or pH sensor as the source that will 

control this loop: Chlorine.
5. Press the Enter button to save the setting.

6. Scroll down � 1 menu to the Loop 1 Rng menu.
7. Press � to enter Edit Mode.
8. Select the minimum and maximum process values for the current 

loop output: 0 to 5 ppm.
9. Press the Enter button to save the setting.
10. Exit to the View Menu. 

System Start-up: Step 6 (last step)
Confi gure the current loop and relay functions if applicable. The current and relay outputs can be tested in the Options Menu.
This concludes the system start-up procedure.

E X A M P L E

Calibrate Menu 

Set and save

Set and save

  Loop 1 Source:            
  Chlorine      >Step 2

Loop 1 Rng: ppm
  0.00   5.00  >6

E X A M P L E

1. Take a water sample from the Sampling Port (after purging it) 
from a stabilized and running system.

2. Use this sample to measure the chlorine content with a 
colorimetric DPD test kit (not included). Refer to the DPD kit 
instructions on how to perform this test.

3. Record the test results.

Example: Set the Chlorine In-Process to 2.67 ppm.

4. Go to the Calibrate Menu.
5. Scroll down � 2 menus to the Cl In-Process menu.
6. Press � to enter Edit Mode.
7. Enter the chlorine reading determined from the DPD test into the 

edit screen: 2.67 ppm. The Cl ppm is editable and must be at 
least 0.2 ppm. 

8. Press the Enter button to save the setting.
9. Exit to the View Menu.

Calibration is complete for the chlorine sensor.

E X A M P L E

  Cl In Process
 Calibration:   >

In Proc:  ppm&nA
 2.67  /  103.8

ENTERENTER

E X A M P L E

Calibrate Menu 

DPD Cl ppm value
entered here.

Step 5

7

The signal level during an In-Process 
Calibration must be at least 1 nA higher 
than the previous Zero Calibration point.

 8. Output Settings - Current Loops and Relays

7.3   In-Process Calibration
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8.2 Mechanical Relay Functions

The 8630 relays are selectable and con� gurable and can be used 
as switches that respond when the process value moves above or 
below a user de� ned setpoint. They can be used for Low Alarm, 
High Alarm or Proportional Pulse triggering related to the process 
value. Relay functions, hysteresis and time delay settings are set 
up in the CALIBRATE menu and can be tested in the OPTIONS 
menu.

 Low Setpoint:
Relay is activated when the measured value is less than 
the setpoint.

Hysteresis

Time

Low Setpoint

Process

Relay energized
Relay de-energized

1 4 mg/l

O
ut

pu
t (

pu
ls

es
 p

er
 m

in
ut

e)

Ending 
Point

Input (mg/l)
Starting 

Point

0

20

40

60

80

100

Pu
ls

e

 Pulse-frequency Operation:
The transmitter can output a pulse at the rate de� ned by the 
settings in the CALIBRATE menu and the sensor input. The 
maximum pulse square wave output from the relays is 400 pulses 
per minute. Example usage would be to control solenoid operated 
dosing pumps.

Example: As the process value drops below the setpoint (4 mg/l) 
the output will start pulsing in relation to the process value, the 
maximum pulse endpoint and the programmed pulses/minute. 
The pulse rate will increase as the process value decreases and 
approaches the programmed endpoint. This functionality can be 
used to precisely control the process.

• The output will be 0 pulses/minute when the input value is 
greater than 4 mg/l.

• The output will be 35 pulses/minute when the input value is 
 3 mg/l.
• The output will be 100 pulses/minute when the input value is 
 1 or less.

The starting point, endpoint and maximum pulse rate are select    able 
in the CALIBRATE menu.

Hysteresis

Time

High Setpoint

Process
 High Setpoint:
Relay is activated when the measured value is higher than 
the setpoint.

Time

High Limit

Hysteresis

Hysteresis

Low Limit

Process

Window

 Window:
Relay is off within the window of two setpoints minus the 
hysteresis. Relay is activated when the value is higher or lower 
than the high and low setpoint.

 Output Settings - continued
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Example: Set a relay to trigger on at a low setpoint of 1.0 ppm 
with a time delay of 15 seconds and turn off at 1.30 ppm.

• Once a setting is saved it becomes immediately active.

1. Go to the Calibrate Menu.
2. Scroll down � to the Relay 1 Mode menu.
3. Press � to enter Edit Mode.
4. Scroll down � and choose Low.
5. Press Enter.

6. Scroll down � to the Relay 1 Source menu. The default is 
Chlorine which is what we want in this example.

7. Scroll down � to the Relay 1 Setpnt menu.
8. Press � to enter Edit Mode.
9. Set the ppm value to trigger the relay: 1.00 ppm.
10. Press Enter.

11. Scroll down � to the Relay 1 Hys menu.
12. Press � to enter Edit Mode.
13. Set the hysteresis (dead zone) for this relay. This affects the turn 

off only: 0.3 ppm.
14. Press Enter.

15. Scroll down � to the Relay 1 Delay menu.
16. Press � to enter Edit Mode.
17. Set the turn-on delay in seconds for the relay: 15 secs.
18. Press Enter.
19. Exit to View Mode.

• Relay function can be tested in the Options Menu.

E X A M P L E

Calibrate Menu 

Set and save

  Relay 1 Mode:            
       Low      >Step 4

Set and save

 Relay 1 Source:
     Chlorine   >6

Set and save

Relay 1 Setpnt:
    1.00 ppm    >9

Set and save

Relay 1 Hys:
    0.30  ppm   >13

Set and save

Relay 1 Delay:
   15.0  secs   >17

E X A M P L E

  8.3   Relay Settings

Relay energized
Relay de-energized

1.00

1.30

Time

Cl ppm

Time Delay

Low 
Setpoint
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Section III - Signet 2650-7 Chlorine and 2750-7 pH DryLoc® Amperometric Electronics

CAUTION!
•   Remove power before wiring.
•   Follow instructions carefully to avoid personal injury or damage 

to the electronics.

 1.   Installation

Avoid skin or eye contact with electrolyte solution.
Wear rubber gloves and goggles.
Material Safety Data Sheets (MSDS) are available online at

 www.gfsignet.com.

• Free chlorine electrodes are pre-� lled with electrolyte solution. Simply 
pull off the protective boot from the end of the electrode and install the 
electrode into the � ow cell � tting.    

Do Not Use Lubricant or 
Sealing Tape on Threads.
Do Not Overtighten. Do Not 
Use Tools.

• Remove applicable sensor access plugs from the � ow cell (Section I, Figure 1).  Holding the 3-2650-7 or 3-2750-7 electronics 
inverted open the DryLoc® connector by turning the upper locking ring ¼-turn counter-clockwise, insert the electrode facing up. 
Turn the locking ring ¼-turn clockwise to lock the electronics in place. The mechanism will “click” when it is locked.  Install the 
complete assembly into the � ow cell and insure the key on the electrode aligns with the key slot on the � ow cell.

Signet 3-2724-00 
Flat pH Electrode

Signet 3-2630-2 
Chlorine Electrode
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 2. Wiring

Wiring to the Signet 8630 Chlorine Transmitter

• Refer to the wiring diagram above to connect the 2650 cable to the terminals on the 8630 Chlorine Transmitter.
• For calibration and con� guration please refer to the 8630 Signet Chlorine Transmitter (section II).

Chlorine Digital (S3L) Wiring

The electronics are pre-wired from the factory to the transmitter. Refer to the following schematics when replacing the electronics.

18
17
16

Signal Ground

Digital (S3L) data

+5 VDC

White

Red

Black

Shield

pH
Signet 3-2750-7

N/C

Gnd

I/O

V+

15
14
13

Signal Ground

Digital (S3L) data

+5 VDC

White

Red

Black

Shield

Chlorine
Signet 3-2650-7

N/C
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CAUTION!
1   Follow instructions carefully to avoid personal injury or damage to electrode.
2.   Prior to installation or removal:
        a.  Disconnect � ow through system.
        b.  Drain below sensor level.
3.   Con� rm chemical compatibility before use.
4. Do not alter product construction.

Section IV - Signet 2630 Amperometric Chlorine Electrode

 2. Overview

Electrode Range: The electrode must match the type and 
range of chlorine concentration to be measured. 

Flow Rate:
The electrode must have a stable and constant � ow of water 
past its membrane for accurate measurement. 

When the sensor is installed in the Flow Cell Block 
3-4630.392 (159 001 690), the � ow rate range is controlled by 
the internal � ow regulator and the � ow rate is reduced to 30.24 
to 45.36 LPH (8 to 12 US g/h). 

Sensor Conditioning: 4 hours
A new electrode requires conditioning of 4 hours with the 
electrode powered on and water � owing past the membrane to 
generate a stable reading. 
Subsequent start-ups can require an electrode conditioning of 
up to two hours.

 1. Operation

The maximum allowable operating pressure must be 
less than 1 bar (15 psi). Higher pressures will damage 
the electrode.

The electrode should not be used in water containing 
surfactants, oils, organic chlorine or stabilizers such as 
cyanuric acid.

Gold cathode

Silver anode

PVDF
membrane

AgCl

e- (loss) e- (gain)
HOCl

current flow

Mfr. Part No. Code Chlorine Range Chlorine Type
3-2630-2 159 001 662      0 to 5 ppm (mg/l) Free chlorine

Chlorine Measurement by Amperometric Sensors
Signet chlorine sensors are membrane-covered amperometric 2-electrode sensors. A gold or platinum cathode acts as the working 
electrode with a silver halide acting as the counter electrode. Depending on the species to be analyzed, a polarization voltage is 
applied between the two electrodes. When placed into service, the chlorine species of interest diffuses across the membrane and is 
reduced at the cathode surface. For the case of total chlorine, the analyte reacts with the � ll solution to produce an intermediate, which 
is subsequently reduced at the cathode surface. At the same time, the silver anode is oxidized to form a silver halide. The current 
generated at the cathode is proportional to the rate of diffusion through the membrane and the concentration of chlorine in the sample. 
The current from the cathode to the anode is conditioned, digitized and transmitted by the associated electronics.

Chlorine in Water
Various forms of chlorine are used to disinfect water. Each form 
of chlorine has bene� ts and limitations which help determine 
the speci� c application. The predominant categories used in 
disinfection are Free Chlorine, Total Chlorine and Chlorine 
Dioxide. Free Chlorine is the sum of chlorine gas (Cl2), 
hypochlorous acid (HOCl) and hypochlorite (OCl-). Above pH 
4.0 all of the molecular chlorine is converted to HOCl and OCl-. 
Hypochlorous acid is a more potent disinfectant than hypochlorite 
and exists in a pH dependent equilibrium as shown in Figure 1.

Free chlorine also combines with naturally occurring or human-introduced nitrogen compounds in the water to form chloramines, also 
known as combined chlorine. Treatment operators introduce ammonia into the water to form monochloramine (NH2Cl), dichloramine 
(NHCl2) and trichloramine (NCl3). Chloramines are a less effective disinfectant but have a longer residence time than the free chlorine 
species. GF Signet sensors cannot detect or monitor chloramines.  Total chlorine is the sum of free chlorine (Cl2, HOCl and OCl-) and 
combined chlorine (NH2Cl, NHCl2, NCl3). 

Lubricate O-rings with a 
non-petroleum based, 
viscous lubricant (grease) 
compatible with the 
system.
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 3. Calibration
A new chlorine electrode or one that has had the membrane cap changed must be calibrated. Refer to section II, 8630 Transmitter 
information on calibration of the chlorine sensor.  A diethyl-p-phenylenediamine (DPD) colorimeter test kit (not included) is required for 
sensor calibration. A sample is taken and analyzed with the DPD test kit, then this value is entered into the Signet 8630 transmitter.

• Calibrate after a membrane cap change (requires 4 hour stablization time).
• Calibrate after the internal electrolyte is replaced (requires 2 hour stabilzation time).
• Check calibration one day after sensor is placed in service.
• Check calibration weekly to monthly depending on process requirements.

The sensor membrane and internal electrolyte solution must be replaced over the life of the electrode.  GF Signet recommends that 
the internal electrolyte and membrane be replaced every 3 to 6 months to maintain accurate chlorine measurements.  Actual interval 
between maintenance of the sensor will be dependant on the actual applications, chlorine level and contaminates in the water.

A weekly inspection is recommended.  If the membrane becomes dirty, rinse with fresh water only.  Do not use brushes, detergents 
or solvents. If a fresh water rinse does not clean the membrane, it will need to be replaced. Keep spare membrane caps available. 
Membrane caps carry no warranty.

pH Compensation for Free Chlorine
Amperometric free chlorine sensors measure only 
hypochlorous acid. As noted in the text above and 
in Figure 1, the ratio of hypochlorous acid and 
hypochlorite is pH dependent. In many applications 
the process pH is relatively stable and no correction is 
needed. However, where the pH of the water changes 
signi� cantly, accurate free chlorine measurement 
requires pH compensation. With the addition of a pH 
sensor, the Signet 8630 transmitter will automatically 
compensate the free chlorine reading for changes in pH.  
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Figure 1

Automatic pH Compensation and Free Chlorine
In many applications, the process pH does not signi� cantly 
� uctuate and only a sensor and instrument is necessary for 
accurate chlorine measurement.
It is when the pH varies that free chlorine concentration can 
not accurately be determined without the use of automatic pH 
compensation.

The addition of the Signet 3-2724-00 (159 001 545) pH 
electrode along with its 3-2750-7 (159 001 671) preampli� er 
to the system makes pH compensation extremely easy and 
automatic even with wide � uctuations or high pH.

See Figure 2 for pH variation recommendations.

Example:
If the pH nominal value is 7.5 and the pH variation is ± 0.2 then 
automatic pH compensation is recommended.
If the pH nominal value is 7.0 and the pH variation is ± 0.2 then 
automatic pH compensation is not required.
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1.1 Removing the electrode from In-line installations

The use of this product assumes that operators are trained and are familiar with this type of device. 
They should be knowledgeable of the potential risks associated with pressurized piping systems. 
Operators MUST follow all necessary safety procedures.

In-line removal Instructions:
1. Depressurize and vent the piping system.
2. Drain the system to below sensor level.
3. Wear safety goggles or face shield during removal.
 Use all appropriate eye, face, hand, body and/or respiratory protection when working with chemicals or solvents.
4. Place a Lockout tag on the pipe when the sensor is removed for maintenance to prevent accidental opening and exposure to 

potentially hazardous chemicals.

Section V - Signet 2724 DryLoc pH Electrode

 1. Dimensions

2.1  Operating Temperature and Pressure Specifi cations

109 mm
(4.3 in.)

25.4 mm
(1.0 in.)

Threads:
¾ in. NPT

44.45 mm
(1.75 in.)

Max. Temperature/Pressure Rating
Operating Temperature Range*: 
 –10 °to 85 °C (14 to 185 °F)
Operating Pressure Range:
 –10 to 65 °C (14 to 149 °F),
 0 to 6.9 bar (0 to 100 psi)
 65 to 85 °C (149 to 185 °F),
 linearity derated 6.9 to 4.0 bar (100 to 58 psi)

0
-40 -20 0 20 40 60 80 100 120

°F
°C

-40 -4 32 68 104 140 176 212 248

(bar)psi)
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CAUTION!
1. Use appropriate eye, face, hand, body and/or respiratory protection 

when using chemicals or solvents.
2. Prior to installation or removal:
 a.  Depressurize and vent system.
 b.  Drain below sensor level.
3. Con� rm chemical compatibility before use.
4. Do not alter product construction.

Warning:
3-2724-00 is the only recommended electrode to be 
used in the Chlorine Analyzer System.

Lubricate O-rings with a 
non-petroleum based, 
viscous lubricant (grease) 
compatible with the 
system.
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pH 4 pH 7

     

 2. pH System Calibration

2.1 pH Calibration Procedure
1. Rinse the sensor off in the rinse water cup. Gentle pat dry with a soft, dry cloth or tissue. Warning: Do not let the rinse water drip
 into the buffer solution; this will dilute the solution and may lead to offset buffer values.
2. Gently place the pH sensor in the �  rst buffer solution ( pH 7). Wait until the output from the sensor is stable on the instrument display.
3. Follow the instrument’s instructions regarding buffer recognition.
4. Rinse the sensor with water. Warning: Do not let the rinse water drip into the buffer solution; this will dilute the solution and
 may lead to offset buffer values.
5. Dry the sensor gently by patting it with a dry, clean cloth or tissue.
6. Place the sensor in a cup containing the second buffer solution (pH 4 or

pH 10). The second solution used will depend on the typical pH value of the 
application.

 • If the process value is below pH 7, then use a pH 4 buffer solution.
 • Sometimes pH 10 buffer solution is used when the typical process value 

is above 7 pH, however, pH 4 buffer is suf� cient if pH 10 buffer is not 
available.

7. Wait until the output from the sensor is stable.
8. Follow the instructions in the instrument manual regarding buffer recognition.
9. Rinse the sensor with water. Warning: Do not let the rinse water drip into 

the buffer solution; this will dilute the solution and may cause offset 
buffer values.

10. Dry the sensor gently by patting it with a dry, clean cloth or tissue.
11. If the calibration was successful, put the sensor back on-line. If it was not successful, clean the sensor and recalibrate. If the sensor
 cannot be calibrated, the electrode may need to be replaced.

2.3 Calibration Tips::
1. The pH solutions can be used for calibrating more than one sensor within a day. However, the solutions must remain free of debris
 and must not be diluted by rinse water from previous calibrations.
 Note: Use fresh buffer solutions for best results.
2. Tap or deionized water may be used to rinse the electrodes between each buffer solution.
3. Calibration solutions change value with varying temperature. Sensors will not calibrate properly if the sensor is not at ambient
 temperature. Take note of all temperature variations of the sensors and the calibration solutions.
4. Do not pour used buffer solutions back into the bottle; dilute with plenty of water and �  ush them down the drain.
5. Store electrodes in pH 4 buffer when not in use.
6. Calibrate sensors on a regular basis.
7. If the pH sensor does not calibrate within acceptable limits, clean the electrode and calibrate again. If the sensor continues to
 calibrate outside of acceptable limits, the electrode is spent and must be disposed.
8. Acceptable pH ranges during calibration are as follows:
 
 pH 7: High: 7.8 pH = -50 mV Low: 6.2pH = 50 mV
 pH 4: High: 4.8 = 227 mV Low: 3.2 = 127mV
 pH 10: High: 10.8 = -227 mV Low: 9.2 = -127 mV

Table 2:
Electrode slope is the ratio of mV to pH units.  At 25 °C 
the theoretical slope is 59.16 mV per pH.

2.3  Electrochemical pH vs. mV Ratio
• The mV output from the electrode is created by the interaction 

of the electrode and the � uid. The electrode contains a gel 
that depletes over time, so the instrument must be readjusted 
periodically to maintain system accuracy. The need for 
recalibration varies with each application, but the life of the 
electrode is usually consistent.

• Keep a maintenance log to establish a depletion trend in new 
systems.

• The mV calibration is a two-point procedure. Signet offers pH 
buffer solutions prepared speci� cally for this purpose.

• pH buffer solutions can be used for calibrating more than one 
sensor within a day provided that the solutions are protected 
from debris and are not diluted by rinse water from the 
calibration procedure.

• Use clean water to rinse buffer solutions from the electrode.
• Dispose of all buffer solutions at the end of the day.
• If the pH sensor will not calibrate within acceptable limits, 

clean the electrode and recalibrate. If the calibration results 
remain outside of acceptable limits, the sensor is depleted 
and must be discarded.

• Follow the guidelines of local waste disposal regulations when 
discarding buffer solutions and spent electrodes.

Theoretical mV Values @ 25 °C
pH mV

2 +295.8 mV

3 +236.64 mV

4 +177.48 mV

5 +118.32 mV

6 +59.16 mV

7 0 mV

8 -59.16 mV

9 -118.32 mV

10 -177.48 mV

11 -236.64 mV

12 -295.8 mV
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Second Numeral = Year
5 = 2010
6 = 2011
7 = 2012
8 = 2013
9 = 2014
0 = 2015
1 = 2016
2 = 2017
3 = 2018
4 = 2019

K5K5

The electrode date code indicates the manufacturing date of the electrode.  Electrodes should be put into service as soon as possible 
and should not remain in the box for more than two years. Over time, the storage solution (found in the "boot" covering the electrode 
tip) will evaporate or leak, allowing the delicate sensing tip and reference junction dry.

To rehydrate a dry electrode, soak it in pH 4 buffer for 24 to 48 hours. Electrodes more than 2 years old may still be functional, but will 
take longer to rehydrate. Restoration may not be effective for severely dehydrated electrodes.

First  Letter = Month
N = January
M = February
L = March
K = April
J = May
H = June
G = July
F = August
E = September
D = October
C = November
B = December

 3. Electrode Data Code

Example: K5 = manufactured in April 2010
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• Wash the surfaces with water or soapy water only.
• Use gentle, liquid dish washing soap if necessary.
• Do not use commercial glass cleaning fl uids.
• Use a soft, lint-free cloth.

If your inlet pressure is less than 1 bar 
(15 psi), remove the � ow regulator and 
quick disconnect inlet connector.

Remove � lter screen to clean. If the � lter 
is not desired, it may be removed from the 
system.

Flow Regulator

Servicing the Flow Regulator and Filter

Figure 2

Figure 1

 1. Maintenance - 4630 Chlorine Analyzer System
Sensor Removal

Caution!
Over time, a sensor can get tight in the � ow cell � tting. When removing the sensor, avoid hitting the sensor electronics into the bottom 
of the wiring enclosure if the sensor suddenly releases.

While holding the � ow cell, grasp the yellow electronics as a whole unit and carefully pull upwards, gently rocking back and forth if 
necessary. Once the sensor is loose, disengage the electronics, then remove the sensor.  TIP: A tool can be used to carefully pry the 
sensor electronics up and out if it is dif� cult to remove.

Under certain conditions, a dirty � ow cell and � lter can create a chlorine demand which could lower the chlorine concentration in the 
water � owing past the chlorine sensor. Because of this, it is recommended to clean the � lter and � ow cell on a regular basis.
The frequency of necessary cleaning will depend on the application in which the system is being used and the level of accuracy 
required.

Take care not to damage the components.

 1.1 Cleaning

Step 1. Keep the system powered on.

Step 2. Disable the relays and any output loops.

Step 3. Turn off the water � ow.

Step 4. Remove the sensors from the � ow cell.

NOTE:  It is not necessary to remove the electronics from the sensor.

Step 5. Install the vinyl caps on to the sensor tips or place   
 the tips of the removed sensors in a cup of sample   
 water for temporary storage while cleaning the � ow cell.  
 
              Keep the sensor tips wet and the sensors energized.

Step 6. Remove the � ow cell from the panel by removing the
 knurled nuts (Figure 1).

Step 7. Remove the remaining hardware from the � ow cell.
 (Figure 2).

Service the � ow cell on a clean, dirt free surface to avoid scratches or damage to the � ow cell.

Section VI - Appendix

NOTE: It is recommended that an anti-seizing compound appropriate for the 
application be used during the reassembling of the fl ow cell.

WARNING: Do not disassemble the � ow 
regulator. There are no user serviceable 
parts inside.
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 1.2 O-Ring Installation

1

2

3

6
5

4

New O-ring  
cross section

Old � attened O-ring
cross section

(Replace)

Individual O-rings shown. 
Butt all segment joints together in � nal assembly.

Fit � ush with no gap
 Straight cut

Angle cut O-ring
Fit � ush with no gap

Angle cut O-ring
Fit � ush with no gap

Straight cut

Butt ends together

• The sealing of the � ow cell is accomplished by four cut 
O-ring segments and two round O-rings sealing the � ow 
regulator. Refer to the illustration below for special O-ring 
� tting instructions. Butt all O-ring joints together so there is 
no gap.

• Remove the O-rings during � ow cell disassembly. Both the 
O-rings and all sealing grooves should be examined for 
cleanliness. 

• Wipe all surfaces carefully with a soft, lint-free cloth to ensure 
good sealing.

• The cross section of the O-rings should be round and 
smooth. If they are � attened, their ability to seal is reduced.

• Do not use liquid or paste sealant.

Do not scratch the sealing surfaces of the fl ow 
cell block. Scratches to the sealing surfaces 
can cause irreparable leaks.

Fit all O-ring joints so there is no gap in fi nal assembly.

The 3-4630-391 O-ring kit comes complete 
with two O-rings (5 and 6) and a single cord 
of material that must be cut and fi tted into the 
O-ring groove of the fl ow cell (1 and 4).

CAUTION!
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Tighten the nut just enough to hold 
the block together and keep the 
O-rings in place.

6

Tighten the bolts in three passes to 
speci� cation.

8

 1.3 Flow Cell Assembly

WARNING! 
Do not over tighten fl ow cell bolts. Maximum torque is 8.1 Nm (72 Lb-In).
Over tightening the bolts can damage the fl ow cell.
Do not over tighten the bolts in an attempt to stop a leak.

Install the nut and washers.

5

Install the remaining bolts, washers 
and nuts.

7

12

3

6

5

Torque 
8.1 Nm 

(72 Lb-In)
MAX!

4

Tighten bolts in 3 passes

Install the assembled pressure 
regulator and the two round 
O-rings into the � ow cell.

1

Install the four O-ring 
segments.

2

Insert the center bolt into the 
block.

3

4

Align and place the back block 
onto to � ow cell. Check to be 
sure that the O-rings are seated 
correctly.

9
Install the � ow cell on the panel. 
Screw on the thumb nuts � nger tight.
Do not use tools on the thumb nuts.

NOTE: It is recommended that an anti-seizing compound appropriate for 
the application be used during the reassembling of the fl ow cell.
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 2.1 Storage

 2.2 Disposal

Store electrode between  –10 ºC to 60 ºC 
(–4 ºF to 140 ºF) at a relative humidity 
that does not exceed 95%. The primary 
concerns when storing the electrode is 
membrane dehydration and freezing in 
extremely cold environments.

The electrode is not recyclable. Dispose of properly according to local, state and federal guidelines. 

Storage Time Action

	 7 Days Store electrode in the � ow cell with water to prevent 
      membrane dehydration.

> 7 Days

Store electrode with the protective cover for the membrane 
attached; or immerse the end of the electrode in a small 
container of water to keep the membrane wet. Do not get the 
electrical contacts on the DryLoc end of the electrode wet.

> 1 month

Unscrew the membrane cap and store it fully immersed 
in tap water. Remove the electrolyte from the electrode
by holding it over a container and shaking it or use a syringe 
and needle to withdraw the solution.

DO NOT
FREEZE

Fill and Refi ll Procedure:
When adding electrolyte, be prepared for an accidental spill. 
Working near a sink is recommended.

1. Remove the membrane cap from the front of the sensor.
2. Turn the sensor upside down and shake the sensor vigorously to remove the 

internal electrolyte.
3. Fill supplied syringe with electrolyte solution.
4. Place the electrode on a level surface. 
5. Insert syringe needle fully into one of the four electrode holes while injecting 

with electrolyte solution. The electrode holds approximately 14 milliliters of 
solution. Insert the needle to the bottom to avoid creating bubbles. Carefully 
� ll until solution begins to � ow out of holes. Do not allow the solution to run 
down the electrode and wet the electrical contacts in the DryLoc connector.

6. Slowly screw on the membrane cap � nger tight. Do not use tools.
To avoid damage and contamination, do not touch the white membrane 
surface on the membrane cap.

 2. Maintenance - 2630 Amperometric Chlorine Electrode

It is required to calibrate the sensor after servicing 
the membrance and electolyte. Refer to section II, 
section 7.
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 3. Maintenance - 2724 DryLoc pH Electrode

Problem Suggested Solution

Hard Coatings

Use a dilute acid solution (HCl solution of 5% or less). If the electrode has been used in applications with 
a pH value higher than 7 pH, soak the electrode for 2 to 5 minutes.

Use a dilute alkaline solution (NaOH solution at 5% or less) if the electrode has been used in 
applications with pH values less than 7 pH, soak the electrode for 2 to 5 minutes.

Alternating immersion in acidic and alkaline solutions may be necessary for thorough cleaning.

Soft Coatings Spray or vigorously stir the electrode with a mild detergent, such as dishwashing liquid. Chlorine bleach 
can also be used.

Oily or Organic Coatings Spray or vigorously stir the electrode with a mild detergent or an appropriate solvent that will not attack 
the materials of construction (isopropyl alcohol or similar).

After Cleaning
Always rinse the electrode with water after cleaning.

Soak the electrode in a pH 4 buffer (with KCl if available) for at least 10 minutes after cleaning.

pH electrodes are similar to batteries; they age with time and usage. The following information will help maximize electrode life.

General Tips:
• To ensure uninterrupted operation of critical pH systems, replacement electrodes should be available.
• Store boxed electrodes � at or upright (electrode tip down) to maximize hydration of the glass surface.
• Keep the glass surface wet at all times.
• Soak the sensor tip in pH 4.0 buffer during system maintenance intervals.
• If the sensor dehydrates, soak the sensor tip in pH 4 buffer for 24 to 48 hours, then visually inspect the electrode for surface cracks, 

swelling, or discoloration.
• It may not be possible to restore severely dehydrated electrodes to normal operation.
• High temperatures, strong acids or caustics will increase electrochemical reactions and speed electrode aging.
• Coatings (e.g. grease) on the glass or junction surfaces cause extended response time and inaccurate measurement.
• Never store the electrode tip in deionized (DI) water. Use pH 4 buffer solution to keep the glass wet when out of the process.
• Never store the electrode at temperatures below 0 °C (32 °F) or allow it to dehydrate.
• Never scrape or sand the glass electrode surface.
• Treat glass electrode surfaces with care to prevent accidental breakage.

 3.2 Cleaning

 3.1 Electrode Care and Application
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 4. Troubleshooting - 4630 Chlorine Analyzer

The troubleshooting table below outlines possible causes and remedies related to the � ow cell panel system. Refer to the transmitter 
and sensor manuals for speci� c component troubleshooting.

Problem Possible Cause Remedies

No water � ow

Inlet pressure below 1 bar (15 psi) Check source pressure. Remove regulator if pressure 
is < 1 bar/15 psi

Damaged � ow regulator Replace � ow regulator

Clogged � lter Clean � lter or remove pressure regulator if inlet 
pressure is below 1 bar (15 psi)

Low water � ow

Clogged � lter Clean � lter

Insuf� cient inlet pressure Increase inlet pressure to speci� cation or remove � ow 
regulator

Damaged � ow regulator Inspect or replace

Excessive � ow
Excessive pressure over 8 bar
(120 psi)

Ensure inlet pressure does not exceed
8 bar (120 psi)

Damaged � ow regulator Replace � ow regulator

Flow cell leaks

Incorrect assembly Inspect, clean, and reassemble
Loose bolts Tighten bolts (8.1 Nm, 72 Lb-In Max)
Defective or missing O-rings Replace O-rings
Damaged sealing surfaces Replace � ow cell

Leaks around sensor
Damaged sensor O-ring Inspect or replace O-ring
Damaged � ow cell Inspect � ow cell

Water leaks out of top vent hole

Drain valve closed or plugged Inspect
Hose connections are backwards Connect water source correctly

Outlet drain not below � ow cell Route drain line below � ow cell and vented to 
atmosphere

Algae growth in � ow cell
Low chlorine concentration in water

Locate � ow cell away from light
Exposure to light

Excessive small bubbles in � ow 
cell accumulating on sensors

Water source contains bubbles
Check water sourceWater source is saturated with 

dissolved gasses

Transmitter does not turn on 

No power or external circuit breaker is  
switched off Inspect power and wiring connections

Loose or incorrect wire connections Check connections
Open loop wiring or missing jumper 
wire on terminal 1 (Loop 1) on the 
wiring enclosure terminal block

Replace jumper wire to terminal 1 or connect a loop 
device if the jumper wire to terminal 1 is removed

Chlorine reading too high Breached membrane Replace membrane and � ll solution

Chlorine reading too low

Low � ow rate Check source pressure
Filter clogged Clean the � lter

Sensor conditioning not long enough Allow the sensor to condition for 4 hours
(See 2630 sensor manual for details)

Sensor output drifts
Variable � ow rate Check � ow rate
Clogged � lter Clean the � lter
Contaminated � ll solution Change electrolyte � ll solution

Chlorine Electrode Troubleshooting (see 2630-2 electrode manual)
Transmitter Troubleshooting (see 8630-3 transmitter manual)
pH Electrode Troubleshooting (see 2724 electrode manual)
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 5. Troubleshooting - 8630 Chlorine Transmitter 

Several factors can cause irregular or incorrect readings. The � rst thing to check is to verify that the transmitter and sensors have been 
installed correctly. The list below outlines possible causes and remedies.

Transmitter Troubleshooting
Problem Possible Cause Remedies

Transmitter does not turn on.

Incorrect wiring.
No or low voltage supplied to transmitter.
Blown fuse.
Bad wire connections or splices.

Check wiring, power supply and wiring 
connections.

Display screen is too dark or too dim. Contrast set incorrectly or ambient 
temperature is too high. Adjust contrast in Options Menu.

LCD backlight, relays and sensors do 
not work. No power supplied to terminals 1 and 2. Transmitter requires power to terminals 

1, 2, 3 and 4.

Incorrect temperature reading. Faulty chlorine sensor.
Bad sensor connection. Check connections or replace sensor.

Digital or Current output is erratic.
Electrical noise interfering with the 
measurement.
Sensor malfunction.

Ensure system is properly grounded.
See Sensor Troubleshooting.

Output is not zero when electrode is 
placed in non-chlorinated water.

Electrode not properly conditioned.
Noise interfering with the measurement.
Calibration incorrect.

Condition new sensor for 4 hours. Cap 
replacement or electrolyte re� ll: 2 hours.
Properly ground system.
Replace sensor.

4 to 20 mA output is incorrect.
4 to 20 mA is not scaled same as Loop 
device.
Loop device is not scaled same as sensor.

Re-span loop device to match sensor.

Chlorine Sensor Troubleshooting (see 2630 sensor manual)

Incorrect readings

Sensor conditioning time too short. Run for 4 hours before calibrating.
Membrane cap damaged or contaminated. Clean or replace cap.
Interference from water contaminants. See Specifcations data. 
Low � ow rate. Check � ow.
Air bubbles on membrane. Install � ow cell vertically with upwards � ow.
pH outside working range 
(See Specifcations data). Check pH.

Low or no electrolyte in sensor. Fill sensor with electrolyte.
Membrane cap loose. Inspect/tighten (do not use tools).
Only combined chlorine present when 
measuring free chlorine. Validate with DPD test.

Sensor not making good contact with 
electronics. Inspect and reconnect.

Defective sensor. Replace.

No pH compensation being used. Manually enter pH value in Options or 
calibrate pH sensor.

Cl sensor not calibrated. Calibrate Cl sensor.
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The 8630 error warnings are self-explanatory. An error message can appear under the following circumstances: 
• User input value is out of range 
• Poor electrical connection 
• Sensor is not connected or detected
• Temperature error
• Incorrect sensor type chosen in the Options Menu
• Two calibration points are too close together when calibrating pH or chlorine.

Error Messages Problem Possible Cause Remedies

Sens Data Error Cl sensor data memory error. Cl sensor is not connected.
Damaged sensor.

Check Cl sensor wiring and 
connection.
Perform a "Find New Sensor" or 
recycle power afterward.

 CHK Cl PREAMP Cl preamp is not detected.
Cl preamp is not connected. 
Wrong wiring.
Damaged preamp.

Check preamp and transmitter 
wiring.
Perform a "Find New Sensor" or 
recycle power afterward.

 CHK pH PREAMP pH preamp is not detected. pH preamp is not connected. 
Wrong wiring.
Damaged preamp.

Check preamp and transmitter 
wiring.
Perform a "Find New Sensor" or 
recycle power afterward.

 CHK Cl SENSOR Cl sensor is not detected. Cl sensor not connected. 
Damaged sensor. Check sensor connection.

 CHK pH SENSOR pH sensor is not detected. pH sensor is not connected.
Damaged sensor. Check sensor connection.

  Out Of Range
  CHECK SENSOR pH calibration error. pH values are out of range. Enter proper values during 

calibration.

Standard Too Close
 To Slope!

pH standard calibration point is 
too close to slope point.

Wrong data is entered. pH 
buffer solution used has value 
too close to standard point.

Re-enter correct data. 
Use proper buffer solution at 
least 2 pH units apart from slope 
buffer solution.

Slope Too Close
 To Standard!

pH slope calibration point is too 
close to standard point.

Wrong data is entered. pH 
buffer solution used has value 
too close to standard point.

Re-enter correct data. 
Use proper buffer solution at 
least 2 pH units apart from 
standard buffer solution.

Signal Too Close 
To Other Cal Pt

The signal level of Cl for In-
process calibration is too close 
to the Zero Cal Point. 

The Cl solution used for In-
process calibration is too close 
to Zero Cal. These two points 
must be 1 nA apart.

Use proper solution at least 1 nA 
apart.

Cl Value Must Be 
   > = 0.2 ppm

The Cl value entered during In-
process calibration is too small.

Wrong data is entered. The 
value entered must be at least 
0.2 ppm (mg/l).

Re-enter correct value. 

 5.1 Transmitter Error Messages 
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 Transmitter Error Messages - continued

NOTE:  Whenever a new type of C1 Sensor is connected to the preamp, a power recycling is required.  Another option is to perform a 
"Find New Sensor" under the Option Menu.

Signal Too High
Must Be =< 10 nA

The signal level during Zero 
calibration is too high. Signal 
must be equal or less than 
10 nA.

The sensor is not stabilized. 
The solution used has too much 
chlorine.

Wait for sensor stabilization.
Check solution to ensure that 
the chlorine level is close to zero 
ppm (mg/l).

pH Too High
Must be =< 9 pH value is too high.

During In-Process calibration 
the pH value is too high and 
must be less than or equal to 9.

Check pH.

pH Too Low
Must be >= 4 pH value is too low.

During In-process calibration 
the pH value is too low and 
must be greater than or equal 
to 4.

Check pH.

FCl= – – – – – –
CHK pH SENSOR pH sensor is not detected.

pH sensor is not connected.
Wrong wiring.
Damaged pH sensor.

Check pH sensor connections 
or change pH input to Manual in 
Options Menu.

FCl= – – – – – –
CHK pH PREAMP pH preamp is not detected.

pH preamp is not connected.
Wrong wiring.
Damaged preamp.

Check pH preamp wiring.
Perform a "Find New Sensor" or 
recycle power afterward.

FCl= WRONG SENSOR Wrong sensor is detected.

Different type of sensor is 
connected.
Wrong sensor type is selected 
under Option Menu.

Use correct sensor type.
Perform a "Find New Sensor" or 
recycle power afterward.
Select correct sensor type under 
Option Menu.
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Problem Possible Causes Remedies

Sensor cannot be calibrated.
Output is higher than DPD test 
(out of range).

Sensor conditioning time too short Condition for 4 hours minimum prior to initial 
calibration

Interference from contaminants See Speci� cations data
Membrane cap damaged Replace cap and recondition
DPD chemicals bad Use fresh reagents
pH outside of working range See Speci� cations data

Sensor cannot be calibrated.
Output is lower than DPD test.

Sensor conditioning time too short Condition for 4 hours minimum prior to initial 
calibration

Chlorine content too low DPD value must be greater than 0.5 ppm to 
calibrate

Low � ow rate Check to make sure � ow rate is suf� cient

Air bubbles on electrode membrane Inspect visually. Tap to remove bubbles. Mount at 
an angle.

Low or no electrolyte in electrode Fill electrode with electrolyte
Organic chlorination agents present in water See Speci� cations data
Surfactants in water Remove surfactants and replace cap
Membrane cap coated Clean or replace membrane cap
Membrane cap loose Tighten or replace membrane cap
pH outside working range. See Speci� cations data

Sensor output very low

Sensor conditioning time too short Condition for 4 hours minimum prior to initial 
calibration

Chlorine content too low Add chlorine to validate
Only bound chlorine present. No free chlorine Check for chloramine with appropriate DPD test
Electrode not making good contact with 
electronics Inspect and reconnect

Unstable output from sensor

Air bubbles on electrode membrane Inspect visually. Tap to remove bubbles. Mount at 
an angle.

Membrane damaged Replace membrane. Condition sensor for at least 
2 hours and recalibrate.

Electrode not making good contact with 
electronics Inspect and reconnect

Non-sensor problem
Check 3-2650 Electronics connection to electrode 
(see 3-2650 manual for instructions). Make sure 
connections are dry. Check instrument hookup.

Transmitter error messages related to calibration are detailed in the Signet 8630 Chlorine Transmitter operation manual.

 6. Troubleshooting - 2630 Amperometric Chlorine Electrode 
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 7. Troubleshooting 2750-7 pH Electronics

Problem Possible Cause Remedies

After completing calibration procedure, 
the output values are inaccurate.

Insuf� cient time allowed for electrode 
stabilization during calibration.

Recalibrate, verify that test solutions are 
at room temperature and wait at least 30 
seconds after placing electrode in solution.   

Transmitter Troubleshooting (see 8630-3 transmitter manual)
pH Electrode Troubleshooting (see 2724 electrode manual)
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* Material Safety Data Sheets (MSDS) are available online at www.gfsignet.com.

 8. Specifi cations - 4630 Chlorine Analyzer

 Environmental Requirements
Storage Temperature:

0 to 65 °C (32 to 149 °F) 
Operating Temperature:

0 to 45 °C (32 to 113 °F)
Relative Humidity:

0 to 95%
Maximum Altitude:

2000 m (6562 ft)
Enclosure:

NEMA 4X (with output wire glands sealed)

Standards and Approvals
CE
UL

China RoHS (Go to www.gfsignet.com for details)

Shipping Weight
10 kg (22 lbs)

General
Compatible Sensors:

Signet 3-2630-2 Free Chlorine Sensor
Signet 3-2724-00 Flat pH Electrode

Materials:
Panel: Black Acrylic
Flow Cell:  Acrylic
Wiring Enclosure: Polycarbonate

Wetted Materials:
Acrylic (� ow cell, spacer rings)
Polycarbonate (� ow regulator housing)
Stainless steel (strainer, e-clip, regulator spring, 
� oat)
Polypropylene (valves, vent )
EPDM, FKM (� ow cell O-rings, diaphragm)
PVC, PVDF, FPM (Chlorine electrode)
PPS, Glass, UHMW, PE, FPM (pH electrode)
PTFE (sealing tape on valves, plug and vent)
Polyethylene (plug)

Performance
System Inlet Pressure Rating:

1 to 8 bar (15 to 120 psi)
Pressure Regulator:

< 0.69 bar (10 psi) variation over all ranges of � ow 
and pressure

Electrical
AC Input - Standard Confi guration:

100 to 240 VAC nominal (85 to 264 VAC), 
50 to 60 Hz (47 to 63 Hz), 0.17 A at 100 VAC

DC Input - Optional Confi guration:
12 to 24 VDC ±10% regulated, 10 W, 250 mA max

NOTE:
 Power Supply 7300-0024 (standard with system)
  90 - 264 V, 0.336 - 0.168 A, 0.316 A @ 100 V, 50 to 60 Hz

 Optional power supply 7300-7524
   100-240 VAC, 0.38 - 0.24 A, 50-60 Hz
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 9. Specifi cations - 8630 Chlorine Transmitter

Input Specifi cations:
One Digital (S3L) input from Free Chlorine, 
One Digital (S3L) input from pH sensor

Output Specifi cations:
Current Loop (2 loops provided)

4 to 20 mA, isolated, adjustable span, 
reversible with minimum and maximum 
endpoint adjustment.
Ability to use chlorine or temperature as input
Update Rate: 300 ms
Max Loop impedance:

50 
 max. @ 12 V
325 
 max. @ 18 V
600 
 max. @ 24 V

Relay Outputs:
2 mechanical SPDT contacts with adjustable 
hysteresis and programmable High, Low, Off, 
Pulse or Window range. 
Maximum voltage rating:

5 A @ 30 VDC
5 A @ 250 VAC, resistive load

May be disabled if not used
Time delay: Programmable from 0 to 6400 s

 Environmental Requirements
Operating Temperature:

–25 to 120 °C (–13 to 248 °F) transmitter only
Storage Temperature:

–15 to 80 °C (5 to 176 °F)
Relative Humidity:

0 to 95%, non-condensing
Maximum Altitude:

2000 m (6562 ft)
Enclosure:

NEMA 4X

Standards and Approvals
CE
UL
Manufactured under ISO 9001 and ISO 14001
     China RoHS (Go to www.gfsignet.com for details)

General
Compatible Sensors:

Signet 3-2630-2 Free Chlorine Sensor
Signet 3-2724-00 Flat pH Sensor

Compatible Electronics
Signet 3-2650-7 Amperometric Electronics
Signet 3-2750-7 pH Sensor Electronics

Materials:
Case: PBT
Panel case gasket: Neoprene
Window: Polyurethane-coated polycarbonate
Keypad: Silicone rubber

Display:
LCD: Backlit alphanumeric 2 x 16 dot matrix
Keypad: Silicone rubber
Display update rate: 1 second
Contrast: User selected, 5 levels

Performance
System Operational Ranges/Limits (Chlorine):

Free Cl: 0 to 5 ppm
pH Input Range:

0 to 14 pH
Chlorine Compensation Range:

pH: 5.0 to 9.0 pH (Free Chlorine)
Temperature range:  0 to 45 °C (32 to 113 °F)

Maximum Cable Distance (sensor to transmitter):
Digital (S3L): 30 m (100 ft) maximum
4 to 20 mA output: 305 m (1000 ft) maximum

Electrical
Power Supply Requirement:

12 to 24 VDC ±10% regulated, 250 mA max current
Sensor Power (provided by 8630):

5 VDC ±1% @ 25 ºC, regulated
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Electrical
Input Specifi cations:

Sensor: Raw signal
Temperature: PT1000 RTD

Output Specifi cations:
Digital (S3L): Serial ASCII, TTL level 9600 bps
Maximum Cable Length: 30 m (100 ft)

Power Supply Input:
Digital (S3L) mode:

5 to 6.5 V ± 10%, 3 mA max

Environmental
Storage Temperature:

–20 to 85 °C (–4 to 185 °F)
Operating Temperature:

0 to 85 °C (32 to 185 °F). Electronics only
Relative Humidity:

0 to 95%, non-condensing (no electrode connected)
Enclosure Requirements:

NEMA 4X/IP65 with electrode connected

Standards and Approvals
CE
Manufactured under ISO 9001 and ISO 14001
    China RoHS (Go to www.gfsignet.com for details)

 10.  Specifi cations - 2650 DryLoc Amperometric Electronics

General
Compatible Sensors:

All Signet Amperometric DryLoc Sensors
Compatible Instruments:

Signet 3-8630-3P Chlorine Transmitter
Mounting:

DryLoc connection
Materials: 

Valox® (PBT)
Cable:

4.6 m (15 ft) 3 conductor shielded, 22 AWG
Shipping Weight: 

0.64 kg (1.14 lb)

Performance
Electronics Accuracy: 

        < 5 nA or 1% of reading, whichever is greater             
@ 25 °C over full input range

Temperature: 
± 1.0 °C (PT1000) over full operation range 
(when calibrated at ambient temperature)

System Response:
500 ms (update rate)

Operational Range:
± 450 mV
Resolution: 0.1 nA

 11. Specifi cations - 2750-7 pH Electronics

Electrical
Input Specifi cations:

Input Impedance:  >1011 �
Temperature Drift: ±0.002 pH per ºC
Input Resolution:  0.02 pH,   0.3 ºC

Output Specifi cations:
Digital (S3L):  Serial ASCII, TTL level 9600 bps
Maximum Cable Length:  30 m (100 ft)

Environmental
Storage Temperature:

-20 °C to 85 °C (-4 °F to 185 °F)
Operating Temperature (Electronics Only):

0 °C to 85 °C (32 °F to 185 °F)
Relative Humidity:

0 to 95%, non-condensing
Enclosure Requirements:

NEMA 4X/IP65 with electrode connected

Standards and Approvals
CE
Manufactured under ISO 9001 and ISO 14001

 China RoHS (Go to www.gfsignet.com for details)

General
Compatible Electrode:

Signet 2724-00 Flat pH electrode
Compatible Instrument:

Signet 3-8630-3P Chlorine Transmitter
Mounting:

DryLoc connection
Materials: 

Valox® (PBT)
Cable:

4.6 m (15 ft) 3 conductor shielded, 22 AWG
Shipping Weight: 

0.64 kg (1.14 lb)

Performance
Electronics Accuracy: 

± 0.03 pH @ 25 °C
Resolution:

0.02 pH
Response Time (includes electrode response):

< 6 s for 95% of change
Operational Range:

0.00 to 14.00 pH
Resolution:

0.02 pH

* Valox® is a registered trademark of SABIC Innovative Plastics
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 12. Specifi cations - 2630-2  Amperometric Chlorine Electrode 

General
Polarization Source:

Signet 2650 Amperometric Electronics
Compatible Flow Cells: 

Signet 3-3610-1 (159 001 683)
Signet 3-3610-2 (159 001 684)
Signet 3-4630.392 (159 001 690)

Mounting: 
Signet DryLoc connection

Materials: 
CPVC

Free Chlorine:
Membrane material: PVDF
O-ring material: FPM
Working electrode: Gold
Counter reference electrode: Silver halide

Wetted Materials:
PVC, PVDF, FPM

Performance
Electrode:

Repeatability: ± 0.08 ppm (mg/l) or 3% of selected 
range whichever is less
Slope: 10 to 60 nA/ppm (mg/l)
Response time, T90: < 2 minutes

System: (including electronics and instrument)
Accuracy: < ±3% of electrode signal after calibration
Resolution:  	 0.5% of electrode range

Sensor Conditioning:
New, � rst start-up: 
        4 hours maximum before calibration
Subsequent start-ups: 
        2 hours maximum

Temperature Element:
PT1000, Class B with measurement range of
–50 to 150 ºC (–58 to 302 ºF)
(measurement only, not operating speci� cation)

Operational Ranges and Limits
Free Chlorine Range:
         0 to 5 ppm (mg/l)
Free Chlorine pH Operating Range: 

5.5 pH to 9.0 pH
Operating Temperature: 

0 °C to 45 °C (32 °F to 113 °F)
Maximum Operating Pressure:

Membrane:
   1 bar @ 25 °C (14 psi @ 77 °F)  

Flow Cell:
            8 bar @ 25 °C (120 psi @ 77 °F)

Flow Velocity Across Membrane Surface:
        Minimum: 15 cm/s (0.49 ft/s)
        Maximum: 30 cm/s (0.98 ft/s)
Free Chlorine Cross Sensitivity: 
        ClO2, ozone, bromine
Chemical Compatibility:
        < 50% ethanol/water, < 50% glycerol/water

Environmental Requirements
Storage Temperature (dry):

–10 to 60 ºC (–4 to 140 ºF) 
Operating Temperature:

0 to 45 ºC (32 to 113 ºF)
Relative Humidity:

0 to 95% indoor/outdoor non-condensing to 
rated ambient

Standards and Approvals
CE
Manufactured under ISO 9001
      China RoHS (Go to www.gfsignet.com for details)
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 13.   Specifi cations - 2724 DryLoc pH Electrode 

General
Compatible Sensors:

2750 Electronics
pH temp Sensor:

PT1000 versions are compatible with Signet 2750  
pH/ORP Sensor electronics.

Process Connection: 
¾ in. NPT or ISO 7/1 R¾ threads or Signet � ow 
� ttings

Wetted Materials: 
• pH: PPS, glass, UHMW PE, FPM

Shipping Weight: 
0.25 kg (0.55 lb)

Performance
Effi ciency

>97% @ 25 °C (77 °F)
Ef� ciency indicates the "wellness" of a new electrode. 
Ef� ciency is measured by comparing the actual slope 
(mV/pH) at 25 °C to the theoretical output of 59.16 
mV/pH. An ef� ciency of 97% to 100% is equivalent to a 
slope of 57.39 to 59.16 mV/pH.

Measuring Range:
pH: 0 to 14 pH

Standards and Approvals
Manufactured under ISO 9001 and ISO 14001
       China RoHS (Go to www.gfsignet.com for details)

Recommended Storage Temperature
• The best storage temperature for the 272X pH and 

ORP electrodes is 0 °C to 50 °C (32 °F to 122 °F). 
• The electrode glass will be shattered if shipped or 

stored at temperatures below 0 °C (32 °F).
• The performance life of the electrode will be shortened 

if stored at temperature above 50 °C (122 °F).
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 14.   Ordering Information - 4630 Chlorine Analyzer 

Mfr. Part No.  Code Description
3-4630-20  159 001 691 Chlorine panel, transmitter, free chlorine sensor (0 to 5 ppm) with electronics, no  
      pH sensor
3-4630-21  159 001 692 Chlorine panel, transmitter, free chlorine sensor (0 to 5 ppm) with sensor  
      electronics, pH sensor with electronics

3-2630-2  159 001 662 Free Chlorine sensor, 0 to 5 ppm (mg/l)  

3-2724-00  159 001 545 pH electrode, � at glass, PT1000 temp element, ¾ in. NPT

3-2650-7  159 001 670 Chlorine - Inline Amperometric Electronics, Digital (S3L), 4.6 m (15 ft) cable
3-2750-7  159 001 671 pH - Inline Electronics, Digital (S3L), 4.6 m (15 ft) cable 
3-8630-3P  159 001 673 Panel mount chlorine and pH transmitter

Accessories and Replacement Parts

Mfr. Part No.  Code Description
3-4630.390    159 001 688 Rebuild kit, O-rings, boots, screws, 1 � lter screen
3-4630.391    159 001 689 Pressure regulator with 1 spare � lter screen
3-4630.392    159 001 690 Acrylic � ow cell complete with all components and connections
7300-0024  159 001 693 24 VDC Power Supply

3-2630.391  159 001 674 Free Chlorine electrolyte, 30 ml
3-2630.392  159 001 675 Free Chlorine replacement membrane (1)
3-2630.396  159 001 676 Free Chlorine replacement kit - (2) electrolyte and (2) membranes

3-0700.390  198 864 403 pH Buffer Kit (1 each 4, 7, 10 pH buffer in powder form, makes 50 ml of each)
3822-7004  159 001 581 pH 4.01 buffer solution, 1 pint (473 ml) bottle
3822-7007  159 001 582 pH 7.00 buffer solution, 1 pint (473 ml) bottle
3822-7010  159 001 583 pH 10.00 buffer solution, 1 pint (473 ml) bottle
3-2700.395  159 001 605 Calibration kit: included 3 polypropylene cups, box used as cup stand,
      1 pint pH 4.01, 1 pint pH 7.00

 15.   Ordering Information - 8630 Chlorine Transmitter

Mfr. Part No.  Code   Description
3-8630-3P  159 001 673 Panel mount chlorine and pH transmitter

Accessories and Replacement Parts

Mfr. Part No.  Code  Description
3-2630.391  159 001 674  Free Chlorine electrolyte, 30 ml
3-2630.392  159 001 675  Free Chlorine replacement membrane (1)
3-2630.396  159 001 676  Free Chlorine replacement kit - (2) electrolyte and (2) membranes

3-0700.390  198 864 403 pH Buffer Kit (1 each 4, 7, 10 pH buffer in powder form, makes 50 mL)
3822-7004  159 001 581 pH 4.01 buffer solution, 1 pint (473 ml)
3822-7007  159 001 582 pH 7.00 buffer solution, 1 pint (473 ml)
3822-7010  159 001 583 pH 10.00 buffer solution, 1 pint (473 ml)
3-2700.395  159 001 605 Calibration kit: included 3 polypropylene cups, box used as cup stand, 1 pint 
      pH 4.01, 1 pint pH 7.00



Georg Fischer Signet LLC, 3401 Aerojet Avenue, El Monte, CA  91731-2882  U.S.A.  •  Tel. (626) 571-2770  •  Fax (626) 573-2057
For Worldwide Sales and Service, visit our website:  www.gfsignet.com  •  Or call (in the U.S.):  (800) 854-4090
For the most up-to-date information, please refer to our website at www.gfsignet.com

3-4630.090  Rev E   5/11  English  © Georg Fischer Signet LLC  2011 

 1.   Ordering Information 2630 Amperometric Chlorine Electrode

Mfr. Part No.  Code   Description
3-2630-2  159 001 662  Free Chlorine electrode, 0 to 5 ppm (mg/l)  

Accessories and Replacement Parts

Mfr. Part No.  Code  Description
1220-0021  159 801 182 O-ring FPM
3-2630.391  159 001 674 Free Chlorine electrolyte, 30 ml
3-2630.392  159 001 675 Free Chlorine replacement membrane (1)
3-2630.396  159 001 676 Free Chlorine replacement kit - (2) electrolyte and (2) membranes

3-0700.390  198 864 403 pH Buffer Kit (1 each 4, 7, 10 pH buffer in powder form, makes 50 mL)
3822-7004  159 001 581 pH 4.01 buffer solution, 1 pint (473 ml)
3822-7007  159 001 582 pH 7.00 buffer solution, 1 pint (473 ml)
3822-7010  159 001 583 pH 10.00 buffer solution, 1 pint (473 ml)
3-2700.395  159 001 605 Calibration kit: included 3 polypropylene cups, box used as cup stand, 1 pint 
      pH 4.01, 1 pint pH 7.00

 16.   Ordering Information - 2630 Amperometric Chlorine Electrode

 17.   Ordering Information - 2724 pH Electrode

 18.   Ordering Information - 2750-7 pH Electrode

Mfr. Part No.  Code   Description
3-2750-7  159 001 671  pH electronics, Digital (S3L), 4.6 m (15 ft) cable  

Mfr. Part No.  Code   Description
3-2724-00  159 001 545  Electrode, pH, � at, PT1000,  ¾ in. NPT 

Accessories and Replacement Parts

Mfr. Part No.  Code  Description
3-2750-7  159 001 671 pH electronics, Digital (S3L), 4.6 m (15 ft) cable
3-2759  159 000 762 pH/ORP System Tester (adapter cable sold separately)
3-2759.391  159 000 764 2759 DryLoc Adapter Cable (for use with 2750 and 2760)

3-0700.390  198 864 403 pH Buffer Kit (1 each 4, 7, 10 pH buffer in powder form, makes 50 mL)
3822-7004  159 001 581 pH 4.01 buffer solution, 1 pint (473 ml)
3822-7007  159 001 582 pH 7.00 buffer solution, 1 pint (473 ml)
3822-7010  159 001 583 pH 10.00 buffer solution, 1 pint (473 ml)
3-2700.395  159 001 605 Calibration kit: included 3 polypropylene cups, box used as cup stand, 1 pint 
      pH 4.01, 1 pint pH 7.00


